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Welcome!

Videoconferencing is the next major step in communicating by computer. When you videoconference you 
send and receive real-time video, audio and text, eliminating the delay of e-mail and the lack of body lan-
guage in text-based media. You can use CU-SeeMe to keep in touch with friends and family, conduct busi-
ness meetings or training, or collaborate on projects with co-workers.

This chapter offers an overview of how videoconferencing works, and how CU-SeeMe Pro uses ILS 
(Internet Locator Servers) to simplify finding and  connecting to other users.

CU-SeeMe Conferences

When you communicate with someone using CU-SeeMe Pro, your conversation is called a conference. A 
conference can include video, audio, text, and graphics. CU-SeeMe Pro allows you to connect with people 
several different ways, but for now we’ll look at three kinds of conferencing: 

• Point-to-Point

• Group

• Cybercast

Point-to-Point Conferences

When you make a CU-SeeMe call directly to a person, you are making a point-to-point connection. The 
conversation you have is private, and your computers are connected directly to each other. You can be 
connected through the Internet or through a private network such as a local area network (LAN)  A 
point-to-point conference operates like this:.
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Group Conference

Group conferencing allows two or more people to meet in a conference. The most common way to partic-
ipate in a group conference is to connect to a computer running conference server software, such as White 
Pine’s MeetingPoint Conference Server. Any video, audio, text, or graphics that you transmit is received 
by the conference server, then transmitted to all others connected to the conference. 

When you connect to a group conference, you can choose who you want to see and chat with. CU-SeeMe 
Pro lets you watch up to twelve video windows at once, but there might be more participants in the confer-
ence than just twelve. 

A simplified view of a group conference operates like this: 

Group conferences may be either public or private. In public conferences anyone may connect and partici-
pate. When you connect to a public conference you never know who will also be connected. You can find 
a list of public conference servers on CU-SeeMe World at www.cuseemeworld.com.

Private conferences are restricted by a password. The conference server may be attached to the Internet, or 
to a local area network within a company. Private conferences are often used for business meetings, col-
laboration, and training.

Cybercast Conference

A cybercast (or one-way conference) is similar to television broadcasting. One computer, running confer-
ence server software, transmits audio and video to all users who connect to it. The individual users cannot 
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send video, audio, text, or graphics; they can only receive broadcast data. A cybercast conference operates 
like this:.

Some examples of cybercast conferences are NASA-TV broadcasts of video and audio during space shut-
tle missions, teachers who cybercast their lessons to remote students, and trade shows that broadcast video 
and audio of keynote speakers.
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Connecting to Users Through ILS

Many Internet users are assigned a random network, or IP, address each time they connect to the Internet. 
This can be a problem for CU-SeeMe users who want to directly dial a particular person, since CU-SeeMe 
uses the IP address to make its connection. Even if a user has been assigned a permanent IP address, it isn’t 
easy to remember when you want to call that person.

The Internet Locator Server (ILS) solves this problem by automatically registering the IP address of each 
user every time they connect to the Internet. Instead of connecting to a specific IP address, CU-SeeMe Pro 
users can use the Address book to place a call to a person by name. All you have to do is double-click on 
the name. CU-SeeMe asks the appropriate ILS server to look up the current IP address of the person who 
is being called, and the connection is established.

One advantage of this method is that the Address book can automatically keep track of which of your con-
tacts are online. Say you’ve added your friend Hannah to your Address book. If Hannah is logged on to the 
network, an icon next to her name will glow green, letting you know that you can place a call to her. When 
Hannah isn’t online, her icon is dimmed:

In CU-SeeMe Pro, any contact in the Favorites folder of your Address book will use the ILS server auto-
matically. If a contact isn’t in the Favorites folder you have to tell CU-SeeMe each time you want to see if 
the person is online.

Now that you have an idea of how videoconferencing and ILS works, you’re ready to turn to the next 
chapter, where you’ll see how to install and customize CU-SeeMe Pro.
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Getting Started

This chapter will help you to install CU-SeeMe Pro and to customize it to suit your computer. 

What You’ll Need

To install CU-SeeMe Pro, you’ll need:

• A video camera to send video 

• Speakers and microphone for receiving and sending audio

• The CU-SeeMe Pro CDROM

• Your CU-SeeMe Pro serial number, located on the CDROM case

Before You Start

Before you begin to install CU-SeMe Pro, you should:

• Read the file called README for any last-minute information that may affect your 
installation. The file is located on the CU-SeeMe Pro CDROM, or in the down-
loaded installationkit.

• Make sure your camera is on the list of supported devices. The list is maintained at 
http://support.wpine.com/.

• Close any application programs that are running on your computer, including previ-
ous versions of CU-SeeMe and the CU-SeeMe Listener.

Getting Started
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Installing CU-SeeMe Pro

Getting CU-SeeMe Pro ready to run on your computer can be be done in four easy steps:

1. Install your camera

2. Install your microphone and speakers

3. Install CU-SeeMe Pro

4. Run the CU-SeeMe Pro Setup Assistant

Step 1: Install Your Camera

It isn’t necessary to use a camera with CU-SeeMe Pro, but without one you won’t be able to send video. If 
you haven’t already installed your camera, install it now by following the steps outlined in the camera’s 
documentation. CU-SeeMe will be able to detect your camera as part of its installation process.

Step 2: Install Microphone and Speakers

A speaker and microphone are necessary to hear and send audio over CU-SeeMe. If you haven’t yet 
installed a speaker or microphone, install them now by following the steps outlined in the audio card’s 
documentation.

Step 3: Install CU-SeeMe Pro

Insert the CU-SeeMe Pro CDROM into your computer’s CDROM drive. The installation program should 
launch automatically. If it doesn’t, just select Run... from the Windows Start button, and type 
d:\Setup.exe (replace “d” with the letter of the CDROM drive on your computer). Click Ok to start instal-
lation.

Select Install CU-SeeMe Pro from the choices shown on the screen that appears and follow the instruc-
tions that appear during installation. The installation program will copy files from the CDROM to your 
hard disk, and make the appropriate changes to your computer’s setup files. 

If you already have CU-SeeMe version 2 or version 3 on your computer, be sure to install CU-SeeMe Pro 
into a different directory. If you don’t, you may lose some of your old contact information, since 
CU-SeeMe Pro is designed to run from its own directory. You should also disable automatic startup of the 
CU-SeeMe Listener. Instructions for doing this are included in the README file.

During installation, CU-SeeMe will search your computer for programs that it requires to run properly. If 
you are missing any required programs, a message will appear describing how to install the program from 
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your CU-SeeMe CDROM. Update drivers are also available at http://www.wpine.com/Help/
cu-pro-install-help.asp.

Once the installation is complete, you’ll see the this screen:

Each item with a check mark next to it will be started automatically when you click the Next button. The 
Setup Assistant will automatically run the first time you start CU-SeeMe Pro. You should select Readme, 
which is a list of last-minute changes to CU-SeeMe Pro that contains important information, and Confer-
ence Companion, which will launch CU-SeeMe Pro. 

You may also choose to automatically start Incoming Call Notification, which lets you know when 
someone is trying to place a video call to you. Click Next, then click Finish on the screen that appears to 
complete the installation process and start CU-SeeMe Pro and the Setup Assistant.

A Word About the Assistants

CU-SeeMe Pro includes several Assistants that help you configure various parts of the program. You’ll 
find them to be quick and easy ways to make CU-SeeMe Pro behave just the way you want it to.

The Assistants guide you step-by-step through the configuration process. If you make a mistake on any 
step, use the Back button to back up and correct your error. The Next button takes you to the next step of 
the process. Any time you need a little more information, click the Help button.
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Step 4: Run The Setup Assistant

The Setup Assistant will guide you through the process of personalizing CU-SeeMe Pro. There are five 
categories that need your attention:

• Personal information

• Directory services

• Network setup

• Video setup

• Audio setup

The first time you run CU-SeeMe Pro, the Setup Assistant will also start and guide you through the steps 
necessary to customize the program. You will see the Assistant’s welcome screen, shown below. Just click 
Next to get started. You can run the Setup Assistant at any time by selecting Setup Assistant from the 
CU-SeeMe Pro folder on the Windows Start button. 
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Personal Information

First Name, Last Name, and E-mail are used by the ILS server to identify you and are required fields. 
You must fill in these boxes before you can move to the next screen. Nickname is the name that everyone 
will see whenever you are in a videoconference. If you do not enter a Nickname, your full name will be 
shown.
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Directory Services

CU-SeeMe Pro uses Internet Locator Servers (ILS) to help videoconference users find each other. Each 
time you start your computer, CU-SeeMe Pro registers your Internet (IP) address and email address with 
an ILS server. This is especially useful if your IP address changes each time you connect to the Internet or 
intranet; your friends and associates can instantly contact you through the ILS server. Chapter 1 describes 
how this works.

Pick one of the ILS servers in the list to post your information to. You can change it later if you want to by 
running the Preferences Editor (select Preferences from the Conferencing Companion’s Edit menu).
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Network Settings

Set the Network Bandwidth to reflect the speed of your network connection. CU-SeeMe Pro will auto-
matically adjust its send and receive rates for the best performance for your connection speed.

The Video Encoding adjustments let you choose a combination of video size and quality to transmit. 
Larger size and higher quality take a larger portion of your available network bandwidth. On a slow con-
nection, such as a 56kbps modem, you might find that a small video size and faster video are the best com-
bination. The stop light to the right of the two Video Encoding sliders alerts you to potential problems.

• Green light: Setting is ideal for your connection speed

• Yellow light: Setting will work, but at reduced performance

• Red light: Setting is not appropriate for your connection speed



16     Installing CU-SeeMe Pro

Video Settings

The Adjust Video screen offers you the opportunity to see your local video. Click on the Device button to 
make adjustments to the video. The screen that appears is different for each model of video camera, and 
you should refer to your camera’s documentation for an explanation of its settings. Once you are happy 
with the video that will be sent, click Next to move on.
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Audio Settings

The next several screens are used to configure your microphone and speakers. The Select Devices screen 
lets you pick which playback and input devices CU-SeeMe Pro will use. For example, you might choose to 
send audio from a CD or from an external microphone. Some digital cameras have a built-in microphone. 
The playback and record devices don’t have to be the same.
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The Playback screen lets you set the volume level of your speakers. Click the Start button to hear a 
repeating sound; adjust the volume with the Volume Adjustment slider and click on the Stop button 
when you are satisfied. If you have difficulty hearing the sound, check the volume control on your speak-
ers, or the configuration utility that came with your aduio card.
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In the Recording screen, CU-SeeMe Pro automatically sets the microphone gain. Read the paragraph on 
the screen in a conversational tone of voice, and click the Next button when you are done.
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The Squelch screen measures the background noise in your environment and automatically sets the micro-
phone squelch so that the microphone is only active when you speak. A proper squelch setting will 
improve performance; if the squelch is set too low, background noise will be transmitted across your net-
working connection, reducing the amout of bandwidth available for video and audio. To set the level, click 
on the Start button and remain silent while the counter counts down from five to zero, then click the Next 
button.
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The final audio setting screen combines the microphone gain and squelch level so that you can give the 
audo system a test. Speak in a conversational tone of voice; the green audio signal should appear to the 
right of the squelch level. If it doesn’t, slide the small squelch setting bar to the left until it does. There 
should be no green audio signal when you are not speaking.
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You’ve now finished customizing CU-SeeMe Pro and are ready to make your first connection. Click Fin-
ish to save all of your settings. Remember, you can use the Setup Assistant at any time by starting it from 
the CU-SeeMe Pro folder on the Windows Start button.

Turn to the next page to see how easy it is to start videoconferencing right away with CU-SeeMe Pro!
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Placing a Call to a Group

In a group conference you will be connected to a conference server, communicating with several people at 
the same time. The conferencing server might be connected to the Internet, hosting public conferences, or 
it might be located on a corporate network and used to host business meetings or training sessions. Confer-
ences may also be either public or private. Public conferences are open for anyone to join. Private confer-
ences require you to supply a password before you can enter.

In this chapter you will make a connetion to a public conference hosted on the White Pine Cafe, a confer-
ence server run by the makers of CU-SeeMe. The chapter also points out some of the features of 
CU-SeeMe Pro that you’ll be using most often as you videoconference. The following chapter, “Placing a 
Direct Videoconference Call,” shows you how to make a point-to-point connection using CU-SeeMe Pro.

Follow these steps to join a group videoconference:

1. Start the Conferencing Companion

2. Select a conference server

3. Choose a conference to join

4. Start videoconferencing

Placing a Call to a Group
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Step 1: Start the Conferencing Companion

You should be connected to the network before you start to videoconference. 

If the Conference Companion isn’t already running, start it by clicking the Windows Start button, select 
Programs, and click the Conference Companion icon in the CU-SeeMe Pro folder. After a moment 
you’ll see the Companion’s opening screen:

The Companion organizes all of your videoconferencing needs. The Addresses list keeps track of your 
favorite people and places to visit, while the History page lets you know who called you while you were 
away from the computer. The Home page gives you an instant link to CU-SeeMe World, the World Wide 
Web gathering place for CU-SeeMe users.
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Step 2: Select a Conference Server

Click the Addresses button to open up the address book if it isn’t already open. Once you’ve been video-
conferencing for a while you will build up a collection of favorite places to visit, or your company may 
supply a list for you if you are using CU-SeeMe Pro in a business environment.

Double-click the Favorites folder, then double-click the entry for the White Pine Cafe. Double-clicking 
on a contact or conference in the Addresses list will place a call.

 

Double-click a
contact or conference
to connect
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Step 3: Choose a Conference

You will see a series of messages indicating the progress of your connection, and finally a list of available 
conferences. Each server can host several conferences. Sometimes each conference has a topic for discus-
sion, and sometimes the conferences are kept open for general use. Many servers host public conferences, 
which are open to anyone, as well as private conferences, which require a password to enter.

The White Pine Cafe, which you are connected to right now, hosts a number of public conferences that 
you can use any time to meet other videochat users.

For performance reasons there often is a limit to the number of users who can connect to a conference at 
the same time. If you try to connect to a conference and get a message saying that there are too many users, 
either wait a bit and try again, or select another conference.

Choose a conference from the list by double-clicking on its name, or by highlighting it and clicking the Go 
button. The numbers next to each conference name let you know how many users are in the room. For 
example, in the list below Video Chat Room 0 has the numbers (10/2) next to it. This means that 12 people 
are in the room; 10 are sending video, and 2 are not.

Double-click a conference
to join



         Placing a Call to a Group     27

Step 4: Start Videochatting!

After a few moments you will be connected to the conference and the  Conference Room will be dis-
played. An example is shown below. The things you’ll need to know right away are:

• The Participant List shows all of the people connected to the conference, whether or 
not you are watching their video.

• A camera next to someone’s name means that they are sending video.

• An eye next to someone’s name means that they can see your video.

• You can see someone’s video by dragging their name from the Participants List onto 
one of the video windows

• To send a text message to everyone in the conference, type it into the Chat box and 
press the Enter key.

• To exit the conference, click on the Hangup button. 

.

You are now online and communicating with other CU-SeeMe users around the world! If you have ques-
tions, don’t hesitate to ask. You’ll find that the CU-SeeMe community is friendly and willing to help new-
comers. You can also read the online help by selecting Help Topics from the Help menu.

Partipant List

Chat Box

Video Windows

Hangup Button
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You’re On Your Way

You’ll soon find that videoconferencing is an easy and efficient way to communicate, whether you are at 
home talking with your grandmother, or at the office participating in a meeting.

An excellent place to learn more about videoconferencing is CU-SeeMe World on the World Wide Web at 
www.cuseemeworld.com. Here you’ll find lists of conference servers to connect to, discussion forums, 
member-to-member e-mail, and tips on getting the most out of CU-SeeMe Pro. 
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Placing a Direct 
Videoconference Call

In addition to joining public or private group conferences, you can place direct calls using CU-SeeMe Pro, 
much like calling someone on the telephone. You can place a call to anyone who is using CU-SeeMe, or 
another H.323-compliant videoconference client such as Microsoft NetMeeting.

There are three ways to place a direct videoconference call:

• Manually

• From the Directory window

• From the Addresses page of the Conferencing Companion

Placing a Direct Videoconference Call
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Placing a Manual Call

To place a manual call, you must know the person’s Internet Protocol (IP) address or computer host name. 
If the person is registered on the same ILS server as you are, you may also use the person’s e-mail address. 
To start the call, select Manual Dial from the Tools menu of the Conferencing Companion, or click the 
Manual Dial button, as shown below.

The Manual Dial dialog box, shown below, is displayed. Type in the address of the person you want to 
call, and click on Manual Dial to place your call.

Manual Dial
button
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Placing a Call From the Directory

Many network users are assigned an IP address at random each time they connect to the network. Placing 
a manual call to such an address is difficult, since you don’t know what the address will be in advance. 

CU-SeeMe Pro uses Internet Locator Servers (ILS) to alleviate this problem. The ILS server records a 
user’s IP address each time they connect to the network. The person’s name is displayed in the directory 
list of the ILS server. You can place a call to the person by finding their name on the list and double-click-
ing it, or by pressing the Speed Dial button, as shown below.

Double-click
to call

Speed Dial 
button
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Placing a Call From the Conferencing Companion

The best way to place direct calls is by using the Conferencing Companion. You can use the Conferencing 
Companion to organize all of your contacts and conferences.

If the person you want to call has a fixed IP address, you can store the address in your list of contacts. 
Select New Contact from the Tools menu, or click on the New Contact button, as shown below. 

The New Contact dialog will appear, as shown below. Fill in the name and IP address or host name  of 
your contactand click Ok. You can then place a call to the contact by double-clicking the entry in your 
Addresses list.
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The contact created in the previous example uses a fixed IP address. You can also drag the new contact 
from the Directory window into the Addresses page.

Only contacts placed in the Favorites folder will automatically check the ILS server and show whether or 
not the contact is online. If the contact is in another folder, you may still double-click on it to place a call, 
but it will not automatically show if the person is online.
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Using Collaboration Tools

CU-SeeMe Pro’s collaboration tools allow you to share work across the network. For example, you may 
want to work together with a colleague in a distant office on the wording of a press release. Traditionally, 
you might use the e-mail or a fax machine to get a copy of the release to your colleague, then try to use the 
telephone to make the necessary changes.

CU-SeeMe Pro lets you work on the document together, with you and your colleague editing a live copy. 
The document is displayed on both computer screens, and when your colleague makes a change, you see it 
instantly. 

Collaboration isn’t just limited to two people. You can collaborate among several users in an H.323-based 
conference hosted on a MeetingPoint conferencing server.

CU-SeeMe Pro collaboration requires that all members of the videoconference have Microsoft NetMeet-
ing installed on their computer. If you don’t have NetMeeting installed, you can install it from the 
CU-SeeMe Pro CDROM or the installation kit that you downloaded from the White Pine store. Microsoft 
NetMeeting is also available from Microsoft at www.microsoft.com.

This chapter describes how to collaborate using:

• Application sharing

• Whiteboard

• File transfer

Using Collaboration Tools
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Application Sharing

CU-SeeMe Pro’s application sharing allows you to share an application across the network. The applica-
tion needs to be installed and running on only one computer. In the following description, the Microsoft 
Windows Notepad application is shown in a point-to-point connection, however the application may be 
any program that you choose. Additionally, the example shows a point-to-point call. You may also collab-
orate with several users in a conference.

In order to share an application, take the following steps:

1. Each person in the collaboration must enable collaboration services

2. Members join a conference or make a direct call

3. One person starts and enables the application to be shared

4. Each person starts collaboration

5. Each person takes turns working in the application

6. One person saves changes

You can continue to use all of CU-SeeMe Pro’s videoconference features during collaboration.



         Application Sharing     37

Step 1: Enable collaboration services

To enable collaboration services, enter the Preferences Editor by clicking on the Preferences button in the 
Conferencing Companion, shown below.

Click the Preferences button
to start the Preferences Editor
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In the Preferences Editor, choose Collaboration and select the Enable Collaboration Services checkbox, 
as shown below. Each participant must do this on their own computer. The setting needs to be changed 
only once. 

1. Select 
   Collaboration

2. Select Enable
    collaboration services 

3. Click Ok
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Step 2: Make a point-to-point call

Place a call to the other participant. You can make a manual call, using the Manual Dial feature of the 
Conferencing Companion, or select someone from an ILS directory listing in the Directory window. If you 
have an entry in your Addresses list simply double-click the entry to place a call, as shown below.

Once the connection has been established, the Conference Room will be shown.

Icon shows this
person is online

Double-click to
place a direct call
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Step 3: Select an application to share

Choose the application that will be shared. In this example, the application is the Microsoft Windows 
WordPad. Start the application in the way that you normally do, and open any files that you want to collab-
orate on.

In the following figure, WordPad has been started, and a file containing a draft press release has been 
loaded.
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If you are the person running the application to be shared, select the Share Application from the Collab-
oration menu in the Conference Room. A list of appliations running on your computer will be displayed. 
Select the application by clicking on it, as shown below. (Note that the collaboration toolbar has been relo-
cated to the left in the figure below for clarity.)

   

Select the
application
to be shared
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Step 4: Start collaboration

Each person should now select Collaborate from the Conference Room Collaboration menu as shown 
below. The shared application will be displayed on each participant’s computer screen.

 

Choose Collaborate on each
participant’s computer
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Step 5: Take turns working

Each participant may now work on the document, and everyone else collaborating will immediately see 
the changes. To signal that you want to work on the document, click the left mouse button to take control 
of the application. Other participants will see a small cursor with the name of the person currently in con-
trol, as show below:

SeeMore
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Step 6: Save changes and disconnect

One person should always save changes before closing the videoconference or turning off collaboration. 
Normally this would be the person sharing the application, however anyone in the collaboration may save 
the file.

Choose Hangup from the Conference menu, or press the Hangup button on the toolbar to close the call.
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Whiteboard

The CU-SeeMe Pro Whiteboard is an application that lets you share graphics and text during a collabora-
tion session. It is similar to a paint program, and is installed when you install CU-SeeMe Pro.

To use the Whiteboard to collaborate, follow Steps 1 and 2 in the Application Sharing section of this 
chapter to enable collaboration services and place a videoconference call.

Once the call is established, one person should select Whiteboard from the Collaboration menu of the 
Conference Room, or press the Whiteboard button, as shown below.

Select Whiteboard
from the menu

Whiteboard 
button
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When any participant in the collaboration starts the Whiteboard, the Whiteboard is displayed on all of the 
computers that are connected. You can use the Whiteboard to share text and graphics, as shown below.

You can get information on using all of Whiteboard’s feature by selecting Help Topics from the White-
board Help menu.
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File Transfer

CU-SeeMe Pro offers file transfer during collaboration. To transfer a file from your computer to any other 
computer involved in the collaboration, choose the name of the participant you want to transer the file to 
from the File transfer selection on the Collaboration menu, as shown below.

Next, choose the file that is to be transferred from the file browser that appears:
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Once the file transfer is complete, a dialog is displayed, as shown below.

The file will be saved by default in the directory shown in the Collaboration section of the Preferences 
Editor. You may choose another location on your computer to receive files by clicking on the Browse but-
ton, as shown below. You may also choose to refuse files sent to you during CU-SeeMe Pro collaboration.

Select a location
to save transferred
files to

Select to refuse
transferred files
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Exploring CU-SeeMe Pro

CU-SeeMe Pro is designed to be completely configurable to the way that you like to videoconference. 
This chapter is intended to be a starting point for further exploration. It highlights the major components of 
CU-SeeMe Pro, and gives some suggestions on ways to customize the Conference Room to fit your own 
personal style.

CU-SeeMe Pro Components

CU-SeeMe Pro is made up of several components. You will use one or more of these components as you 
connect to and participate in a videoconference or point-to-point call:

• Conference Companion

• Conference Room

• Directory
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The Conference Companion

The Conference Companion, shown below, is the starting place for all of your videoconference calls. It 
gives you access to your personal list of conferences and contacts, a summary of recent incoming calls, 
and buttons to place calls manually or to view the participants on an ILS directory server.

 

Create your own
folders to organize
your contacts and
conferences

See a list 
of recent
incoming calls

Place a videoconference
call manually View the list of

contacts on an
ILS server

Edit your personal
preferences

Add new group folders,
contacts, and conferences

Double-click on a
conference or conact
to launch the
Conference Room

Read 
up-to the-minute
information about
CU-SeeMe Pro

Manage your
list of personal
contacts and
conferences
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The Conference Room

The Conference Room gives you complete control over sending and receiving video, audio, and text dur-
ing a videoconference call.

Enter text here to
 send it to participants

Read text sent
by other
participants

Choose to send text
to the entire conference,
or to an individual

Adjust the number of
video windows to display

Set the volume and
gain for your speaker
and microphone

Select which
participants
to see

Access conference
tools such as chat
macros and 
collaboration

Right-click on
video windows
for convenient
pop-up menus
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The Directory

The Directory window shows you an up-to-the-minute list of participants that are online and registered 
with an ILS server.

Double-click a
contact to place
an immedaite 
call

Drag contacts
into your
Addresses list
in the Conference
Companion

Send an email message
to the selected contactVisit CU-SeeMe World,

the web site for 
videoconference users

Choose the
category of 
user you want
to see

Select the ILS
server to display
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Customizing the Conference Room

The CU-SeeMe Pro Conference Room is completely customizable. You can rearrange, remove, or resize 
all of the Conference Room parts or watch video windows in full-screen mode. Any changes that you 
make will be saved for future session.

In this section you will learn how to:

• Rearrange Conference Room parts

• Remove parts

• View full-screen video
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Rearranging Conference Room Parts

To move a part of the Conference Room, look for its docking bar: 

The docking bar is on the left side of toolbar and menu parts, and on top of other parts. To move a part to a 
new location on the screen, click and hold on the docking bar and drag the part to the new position. 
Release the mouse button. You can drag parts to locations inside the Conference Room, or outside the 
Conference Room, onto the Windows desktop.

If you want to return all of the moved parts to their default locations, select Restore Default from the 
Window menu.

For example, in the figure shown below, the chat window and participant lists have been moved to new 
locations. 

Moving Participant Video Windows

You can move participant video windows out of the Conference Room and place them anywhere on your 
Windows desktop. The videos will by default float on top of any background application windows. To 
move a video window to the desktop, click and hold on its title bar (located at the top of the video win-
dow), and drag the window to the Windows desktop.

Docking bar 
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Removing Conference Room Parts

To remove a part from the Conference Room, open the Windows menu and deselect the part’s name. To 
restore a part that has been removed, open the Windows menu and select the part’s name.

For example, in the Conference Room shown below, the participants list and all of the menus have been 
removed, leaving only the chat window and the video windows.
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Viewing Full-Screen Video

You can display all of the Conference Room participant video windows in full-screen mode. This is useful 
when you are using a microphone and speaker to send and receive audio among conference participants. 
Select Full-Screen from the Windows menu to show full-screen video. 

In full-screen mode, you may elect any of the Conference Room parts to be displayed along with the par-
ticipant videos. Right-click on an empty portion of the screen to display the Windows menu and select the 
parts that you want to see.

To return to the Conference Room, press the Escape key.

The example show below shows the Conference Room in full-screen mode:
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Getting Help

Help for CU-SeeMe Pro is available in several forms.To learn more about features of CU-SeeMe Pro, con-
sult the online help documents on the Help menu. The following sections describe how to register your 
copy of CU-SeeMe Pro, receive technical support, and contact our offices.

You may also communicate with other videoconference users on CU-SeeMe World, the World Wide Web 
meeting place for videoconferencing at www.cuseemeworld.com.

Getting Help
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Getting Technical Support

White Pine Software provides 90 days of free telephone support to all registered users after purchasing and 
registering the product.  

Registering CU-SeeMe Pro

You must register with White Pine in order to receive technical support. If you purchased CU-SeeMe Pro 
from our online Storefront, you are automatically registered. Other users can register in any of the follow-
ing ways:

• Complete the registration card included with CU-SeeMe Pro and mail it to White 
Pine.

• From the Help menu in CU-SeeMe Pro, click Registration. This opens a Web browser 
and displays the White Pine Software Product Registration Web page, allowing you 
to register your copy of CU-SeeMe Pro online. 

• Using any Web browser, go to the CU-SeeMe Web Pro page at 
http://www.wpine.com and select Register CU-SeeMe. Fill out the online form to 
register your copy of CU-SeeMe Pro.

Support on the World Wide Web

The White Pine Web pages offer a variety of information about the company, products, and demo versions 
of released software, in addition to technical support.

The Technical Support pages offer online registration, technical support through an interactive form, and a 
list of Frequently Asked Questions about using CU-SeeMe Pro.

You can reach the White Pine Software technical support Web page at 
http://support.wpine.com/cuseeme.
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Before You Contact Technical Support

White Pine Software provides technical support to registered users. Return your user registration card 
promptly or register CU-SeeMe Pro using online registration. Product registration guarantees you new 
product notification and product upgrades.

To get your problems solved as quickly as possible, the technical support staff requires as much pertinent 
information as possible. If you can supply us with this information at the time of your call, we can under-
stand and resolve your problem much faster. You should have this information ready and be at your com-
puter when you call for technical support and be ready to reproduce the problem while talking to a 
technical support staff member.

Please fill out the following information before calling:

Serial #:

Product:

Version:

Date Purchased:

Original Purchaser:
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Your Computer Configuration

Make and Model: 

Microsoft Windows  Version: 

Disk Space: 

Memory (RAM): 

Video Card Manufacturer and Model: 

Video Capture Card Manufacturer and Model: 

Sound Card Manufacturer and Model: 

Camera Manufacturer and Model: 
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Communications Configuration

Internet Connection:

Ethernet:        ISDN:         Modem:

Modem Manufacturer and Model:

Model of your Ethernet board:

Network drivers and other communication software installed on your system:

• TCP/IP Driver:

• Dial-up PPP (if using a modem):

• Internet Service Provider (ISP): 
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Contacting White Pine Software

Technical Support

Online form: http://www.cuseeme.com/cu-support.html
Phone: 603-594-28048:00 am - 8:00 pm EST

Corporate Headquarters

White Pine Software, Inc.
542 Amherst Street
Nashua, NH 03063 USA
Phone: 603-886-9050
Fax: 603-886-9051
E-mail: info@wpine.com
WWW: http://www.wpine.com 

Sales Hot Line

For more information about all White Pine Software products, please contact the White Pine Software 
sales department. Demos and product information are also available on the World Wide Web. 

U.S. E-Mail: info@wpine.com
U.S. Phone: 1-800-241-PINE (7463)

Europe E-Mail: euro-info@whitepine.fr
Europe Phone: +33.4.93.59.43.43

WWW: http://www.cuseeme.com

European Headquarters

White Pine Software, SA
9551, route de Saint Laurent du Var
06610 La Gaude France
Phone: +33.4.93.59.43.43
Fax: +33.4.93.24.76.06
E-mail: euro-info@whitepine.fr 



           Index     63

A
Application sharing 36
Assistants

navigating 11
running the Setup Assistant 11

Audio
settings 17

B
broadcast

see cybercast conference
C
Collaboration

application sharing 36
file transfer 47
introduction 35
Whiteboard 45

Conference
Cybercast 6
Group 6
joining 23
Point-to-point 5
types 5

Conference Companion 50
Conference Room 51

customizing 53
cybercast conference 6
D
Direct connection

from the Addresses page 29
from the Directory 29
manual 29

Directory 52
F
Favorites folder 8, 33
File transfer 47
G
group conference 6
I
ILS

and Address book 8
how it works 8

Installation
preparing for 9
steps 10

O
one-way conference

see cybercast conference
P
point-to-point conference 5
R
registration 59

online 58
S
Setup Assistant 11
T
technical support

Web page 58
V
Video

full screen 56
Video Encoding

adjusting with Setup Assistant 15
videoconferencing

cybercast conference 6
group conference 6
point-to-point conference 5

W
Web page

CU-SeeMe 62
technical support 58

White Pine Software
contact information 62
CU-SeeMe Web page 62
e-mail 62
sales hot line 62
sales phone 62
technical support 58

Whiteboard 45

Index



White Pine Software, Inc. End User License Agreement

THIS IS A CONTRACT. BY INSTALLING THIS SOFTWARE YOU ACCEPT ALL THE TERMS AND CONDITIONS OF
THIS AGREEMENT.

1. White Pine grants to you a non-exclusive, non-sublicensable, license to use this Software in binary executable form.

This White Pine Software, Inc. (“White Pine”) End User License Agreement accompanies a White Pine software product
and related explanatory written materials (“Software”). The term “Software” shall also include any upgrades, modified
versions or updates of the Software licensed to you by White Pine. 

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR DOCUMENTATION, OR ANY COPY
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. White Pine reserves the right at any time to alter prices, features, specifications, capabilities, functions, licensing terms,
release dates, general availability or other characteristics of the commercial release of the software.

3. Title, ownership rights, and intellectual property rights in and to the Software shall remain in White Pine and/or its
suppliers. You agree to abide by the copyright law and all other applicable laws of the United States including, but not
limited to, export control laws. You acknowledge that the Software in source code form remains a confidential trade secret
of White Pine and/or its suppliers and therefore you agree not to modify the Software or attempt to decipher, decompile,
disassemble or reverse engineer the Software, except to the extent applicable laws specifically prohibit such restriction.

4. Copyright. The Software is owned by White Pine and its suppliers, and its structure, organization and code are the
valuable trade secrets of White Pine and its suppliers. The Software is also protected by United States Copyright Law and
International Treaty provisions. You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or
otherwise attempt to discover the source code of the Software. You may use trademarks only to identify printed output
produced by the Software, in accordance with accepted trademark practice, including identification of trademark owner’s
name. Such use of any trademark does not give you any rights of ownership in that trademark. Except as stated above,
this Agreement does not grant you any intellectual property rights in the Software.

5. White Pine may terminate this License at any time by delivering notice to you and you may terminate this License at any
time by destroying or erasing your copy of the Software. In the event of termination, the following sections of this License
will survive: 2, 3, 4, 5, and 6. This License is personal to you and you agree not to assign your rights herein. This License
shall be governed by and construed in accordance with the laws of the State of New Hampshire and, as to matters
affecting copyrights, trademarks and patents, by U.S. federal law. This License sets forth the entire agreement between
you and White Pine.

6. WHITE PINE OR ITS SUPPLIERS SHALL NOT BE LIABLE FOR (a) INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
INDIRECT DAMAGES OF ANY SORT, WHETHER ARISING IN TORT, CONTRACT OR OTHERWISE, EVEN IF WHITE
PINE HAS BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR (b) FOR ANY CLAIM BY ANY OTHER
PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY TO
THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME STATES DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND
EXCLUSION MAY NOT APPLY TO YOU.

7. ACKNOWLEDGEMENT: YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT,
AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN
THE PARTIES RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT.

Should you have any questions concerning this Agreement, please contact in writing:

White Pine Software, Inc., 542 Amherst Street, Nashua, NH 03063.




